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Module 5
This module focuses on common computer actions, including opening Microsoft Word, saving
files, and moving files to a newly created folder.

1. Microsoft Word
Previously, we used a program called Notepad to create a simple text file. This week, we will
introduce a more powerful tool for editing and formatting documents.
Microsoft Word is part of the Microsoft Office Suite which is used in most business environments,
and which is included on all computers provided by PRC.

Along the top of the window are a set of controls for making your document look the way you want
it to look. In the main section of the window is a blank piece of paper, which is where the words you
type will appear.
We aren't going to spend much time in this class with this program, but it is discussed in Windows
Fundamentals, and taught in detail in the Word I, Word II and Microsoft Office Certification classes.

Exercise: Creating a Document in Microsoft Word
1. To Open Microsoft Word:
a) On your desktop, open the Start Screen
b) Type word to locate the Microsoft Word 2010 program

Page 2 of 11

People’s Resource Center

Introduction to Computers – Module 5
c) Click on the Microsoft Word 2010 program
2. In Microsoft Word, type the following lines. Don't forget to use the shift key for capital
letters and the Enter key at the end of a paragraph.
My name is
I am taking Introduction to Computers. It is fun!
3. Use the up arrow key to return to the first line and fill in your name after is
4. In the upper left-hand corner, find and click on the File tab on the tabs for the ribbon.
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5. Click on Save As

Notice the location at the top of the screen. It should say This PC > Documents
Notice the File name. It should start with “My name is”
When you save a new document, Microsoft Word gives a default name based on the first
line of your document. The name and location are the key things you need to know to
find a file on your computer.
6. Click the Save button at the bottom of the Save As window
7. Notice that the Title bar on your Word window (very top of the screen, in the center) now
has the name of the file that you saved.
8. Click on the X in the upper right-hand corner of the Word window to close this window.

2. More with File Explorer and Folders
Previously, we used File Explorer to find a file we had saved and delete it. Now we are going to
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learn more about File Explorer and how information is stored on the computer.
Information is stored on the computer in files. There are many different types of files:


Documents that you have created



The programs that the computer uses to help you do things



Pictures and Music that you may have stored on your computer.



Helper files that are used by the programs on your computer

A modern computer has thousands of files on it before the user creates a single document. The
way in which all this information is organized is that files can be grouped together into a folder.
For all the information on a computer, with everything it can do, only two types of things stored on
the disk are files and folders. A folder can contain files or other folders. A file contains information
in a specific format.
In general, users don't need to worry about the files and folders that are used to store the computer
programs and the information they need. Users typically need to pay attention only to the music,
pictures, videos, documents, and the files that they download from the Internet.
To display the collection of documents stored on a PC, open File Explorer by clicking on the folders
icon on the task bar.
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Typically, the Documents on This PC will be shown in the Frequent Folders list, but if not, you can
click on the Documents label on the left underneath This PC..
When you do, you should be able to find the file you just saved. They appear in alphabetical order.
If there are a very large number of files or folders under Documents, you may need to scroll
down to find yours.

Along the top of the File Explorer is a set of tabs which provide different options in a ribbon. Clicking
on the Home tab will reveal a set of actions which are frequently desired from the File Explorer.
Depending on whether or not you have selected (clicked on) a specific file in the File Explorer,
you will see different options enabled.
If the Home ribbon is not displayed, it can be expanded by clicking here
Following is the Home Ribbon if no file is selected:

Following is the Home Ribbon if a file is selected:
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You can see that some actions are grey in the upper version, but selectable in the lower version.
In either case, you can choose the New Folder option, which will create a folder within the currently
viewed location. If you click on this, a New Folder will be created. The computer doesn't have any
idea what you are going to put in the folder, so the default name it gives is New Folder.

Notice that the name New Folder is selected in dark blue. This means that you can start to type and
give it a better name, based on what you plan to put there. When you are done typing your name,
you can hit the Enter key to indicate you are done renaming it.

To move a file into the folder, you can select the file, choose Move To from the Home Ribbon, and
select the folder location for the destination.

Exercise: Creating a Folder and Moving a File
1. Open File Explorer
2. Go to Documents
3. Create a Folder with your name
4. Make sure that the Word 2010 program is no longer open
5. Move the file created in the previous exercise into the new folder by selecting the
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file, choosing the Move To option from the Home tab of the ribbon, and selecting the
newly created folder with your name
6. Double click on the folder to confirm that the file is in that folder
7. Double click on the file and confirm that the information you saved is in the file.
8. Close Microsoft Word

3. More Web Browsing
Building on the previous module, we will use Internet Explorer web browser to discuss
how the Internet can be used to help in a specific search, using an example of a job
search.

Review Exercise: Opening Internet Explorer Web Browser

Review Exercise: Performing a Google Search
1. Perform a Google Search for job search DuPage, IL
2. Refine the search with a specific skill that you have, or use cook
3. Click on a site that would be of interest if you were looking for that type of job
4. Keep that page open in your browser

Saving a Favorite Web Page
When you have found a web page that you want to return to again later, your web browser
gives you a way to save the address. Called Favorites or Bookmarks, they are a
convenient way to save a small collection of web sites that you want to view multiple
times.
In order to save a page as a favorite once you are on the page, simply click on the Star
icon and then the “Add to favorites” button. The Internet Explorer browser will pop open a
window giving you the opportunity to name it and decide where you'd like to store it. It will
provide a default name (based on the web page title) and location of Favorites folder.
A “Default” is a name or location or value the computer provides, while giving you the
chance to change it before it takes effect. The programs usually try to provide meaningful
defaults, but they don't know what you have in mind, so you may want to change it to
make it more meaningful for you.
The Favorite you save will stay as a Favorite on this browser on this computer until you
delete it, so over time, it can be a good idea to reduce clutter on your Favorites list by
deleting pages that you no longer use.
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Viewing the List of Favorite Web Pages
When you want to return to a previously saved favorite web page, you can find it by
clicking on the star icon in Internet Explorer. (If at home, you are using the Edge browser,
you can click on the List icon consisting of three horizontal lines in the Edge Browser,
labeled “Hub (favorites, reading list, history, and downloads)”).
Be sure that the web page in your active tab is one that you are willing to leave before you
click the favorite, because it will replace the current contents of that tab with the Favorite
you select.

Exercise: Saving and Loading a Favorite
1. Confirm that the current page on your browser has a job or list of jobs that you want
to save.
2. Click on the Star icon and choose Add to Favorites.
3. Make sure the name of the bookmark is meaningful to you (and not too long)
4. The default location of Favorites folder is fine.
5. Click on the Save button
6. In your browser tab, hit the Back button to return to the previous page.
7. Click the New Tab button to open a new tab.
8. Click on the Star icon to show the saved Favorites
9. Click on the name of the Favorite you just saved
10. Confirm that the page has loaded in your new tab
11. Click on the New Tab button to open a new tab
12. In the address bar, type indeed.com

13. Hit the Enter key
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14. Enter the name of the company you found in your previous search. You can click
on the tab to see it, then click back on the tab for Indeed
15. Click the Find Jobs button
16. Review the list of jobs with this company that are listed on Indeed.com

Viewing your Browsing History
There are times when you are using the web and you realize that you want to return to a
page that you were looking at a little while ago, but you can't get to with the Back button.
The web browser keeps a list of pages that you have recently visited, and you can view
(and delete) this list.

4. Filling Out Forms on-line
More and more, filling out paper forms is being replaced by filling out forms using a computer.
Filling out a form mostly involves clicking on the fields and typing the information requested.
You want to be careful about using the Enter key, because sometime that is treated as the “OK” or
“Submit” button.
The Tab key can be used to move to the next field on the form, but check to be sure it takes you to
where you expect.
In general, fields that have a * by them are required for the form, and other fields are optional.
Most forms will validate the information you have entered and report errors if you don't provide what
it expects.
Some forms have fields where you need to choose from a list of options. This can be check boxes,
radio buttons, or a pull-down list.

From the classroom, you can replace steps 1 and 2 below by going to the shortcut link on
the S: drive, and navigating to Training Resources/Introduction to Computers, and
double-clicking “Practice Online Application - Experience Works”
http://www.experienceworks.org/site/PageServer?pagename=Practice_Online_application

Exercise: Filling out a Form On-Line
1. Open the Internet Explorer Browser, or a new tab on the Internet Explorer
browser.
2. In the Address Bar, type:
www.experienceworks.org/site/PageServer?pagename=Practice_Online_application
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3.

Fill out the information on the form. Identify and choose the State from the
pull-down selection
4. For Educational Background try checking and un-checking the check boxes
5. For Resume, try clicking on the different Radio buttons

6. Under Resume, click the “Browse…” button and locate the Resume
Template on the S: drive under Training Resources/Windows
Fundamentals/Week 7. Click “Open” button to attach the file.
7. What are the differences between Pull-down, Check Boxes, and Radio Buttons?
8. Click the Submit button
9. Click OK on the pop-up.
10. Have your instructor confirm that you filled out the mandatory fields properly

5. Review Exercise - Typing Practice
1. Exercise: Find Typing Tutor on your Desktop, Open it, and start using it.
2. On your desktop, locate the Typing Tutor icon.
3. Double click the Typing Tutor icon and follow the instructions on the screen.

6. Vocabulary Summary
Bookmark
Default
Favorite
Ribbon

7. Homework
Practice what we did in class today
Practice typing
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